Vicinity Map Standards
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Vicinity Map Steps

Read entire document before starting your Vicinity map. See the last page for examples of completed maps.
Open GeoWorks: http://gis.slocounty.ca.gov/sites/geoworks.htm. See the Getting Started document for more detailed

examples. To find the Board of Supervisors District click here.

Board of Supervisors Vicinity

Map Standards:

1. Map will be primarily black and
white without an Aerial Image.
The map may be photocopied or
printed in Black and White and
can appear muddy if the imagery
is left on. Page 6: Change Layer Theme
to “PW Vicinity Map”

2. Markup should be added when
appropriate. Page 3& 4

3. The title of the map will be in ALL
CAPITILIZATION and should be
brief but consistent with the BOS
Staff Report Title. Page 7

4. Include WBS or contract number
in title. Use the long title version
of the map template if the title
doesn’t fit. Page 7 & 8

5. The last line of the title will
include the Community. Capitalize
Each Word. Page 7 & 8

6. Arrows will point to the project
site (this will be accomplished in
Adobe Reader). Page 10

7. The Author of the map should be
provided. Use your Windows
Login, not just initials. Page 7

8. Do not use abbreviations. For
Example, CSA should be County
Service Area.

9. Set Scale to a round number. Page 8
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<+ More complicated maps should have legends. See GIS staff to help you with this. Send Staff Report and

screenshot or clear description of project location and map requirements to pw.gis@co.slo.ca.us.
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http://gis.slocounty.ca.gov/sites/geoworks.htm
https://slocountypwd.org/MapFiles/GeoWorks_Docs/GeoWorks_Getting_Started.pdf
mailto:pw.gis@co.slo.ca.us

Vicinity Map Steps
Step A: Find the project location

Search and/or zoom into your project location. For a how-to video on the search bar click here.

Use the Global Search box to search for an APN, Road Number, Road Name, Street Address or Longitude and Latitude.

File Home Map Tools

& lo-| &i- [ T 0 « [&

Pan Circle Line Edit Toggle Enable Snapping  Select Snapping Styles
Measurement Layers

Step B: Define the Project location 1

Select Drawing Style

Marku [0 can be added to the map. For a how-to e | want to.
-—g b@mﬂﬂf}&ﬂ

Create your own style

video on mark up (drawing tools) click here.

Color: Outline Color:
The Style of the markup can be controlled before or 2l Wl
after drawing on the map. When the Markup button et
is selected, the Styles button is visible. Click the Styles — :
button to select the Markup style before placing it on s
the map. Alternatively, use the default style to markup g.‘ _—
= Edit

Line Style:

Solid

the map and use the Edit == tool to change the
style. Click on the Edit tool then click on the markup
that needs to be changed.

File Home Map Tools

" B
Under the “Tools” tab, in the “Drawing Tools” section, select what @ * = - 0 By
type of markup you would like to add to the map (point, line, Fan sl Enable Snapping _ Select Snapping _ Styles
polygon, text) then additional options will pop up. . T ’], 7
Drawig
If needed, click “Toggle Measurement Labels” to turn off e e Hre  Freenene ¢
measurement labels from mark ups. (> o O QO
. Default Freghand Shape Ellipze Circle Polygon
Turn Off Labels (optional) O &
Filter Laye
Rectangle Arrow

g f '%!k){hli‘d!l!!!

Many layers have labels on by default. If you want to
show a layer but find the labels to be too busy you
can turn them off. Click the arrow next to the label
and then select toggle labels.

6 |‘i"m';j’(-m

‘ Parcels Boundaries >

0 Toggle labels
Turn the layer's labels on or off.
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https://slocountypwd.org/MapFiles/GeoWorks_Docs/Videos/01_Search_Bar.mp4
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Vicinity Map Steps

- *
W PW GeoWorks x +
o T T + - s e @ :| ToEditashapeand/oritsstyle onthe map, click on
5 Apps @ PubicWorks| AxGl Kl PWintanet W PWintemet W Record Map Index SServerMans: [ gisdevpubT Sites » ¥ : Edit .
County of Saae Luik Obispa p -~ su" the == button then click on the shape you want
n
EOYYDRKS "= to edit or click on the Style button.
File = Home Map Toals B wolsbes %
M @ & o - ° (7] Created
Fan  Zoomin Fulbxtent Bookmarks  Previous Extent Getting Started Buffer
Layers E x < o
Default - {E} g g
bridge ©  Fitter ! + s
— 4 County Maint. Road System = -
@ % Bridges - County Maintained 5 ;m -J-»._ %. s
@ Other | - e .
S . Additionally, selected features can be buffered to
=L Stommaater mprovement Pans : create a larger “Area of Interest” markup.
%
2P, 5" B af SanLuis Obisps Department ef Publi...
Selected Identify Results (1) 2 %
Feature o ounty Maintained = %
3 Za0mto Al = Description % i state Bridge_MNumber
“ Zoom to extent of all results T—— e

)

Show Buffer Options

Identity features near these results

=
o

=

Export to CSV
EXpORt results to TSV

EXpOIt 1o XLSX
Export results to XLSX

Export to Shapefile
Export results to Shapefile

Markup Style Options

Click on the “Styles” tool to change the mark-

e s i ok up symbology. Depending on the Browser you

== Layess 2 L2 Styles . . .

' ' are using, pre-defined styles will show up or
Fre == the options to “Create your own style” will
Select Drawing Styl X Select Drawing Styl
SeeEng e S NG =E “| show up by default. Each symbol type has a
Type: Type: PW B|aCk Opt|0n.
‘ Choose a style A | | Create your own style v |

Hollow Black Circle

O O ¢ @ m e

Color: Cutline Color:

g £
Marker Size: e

Line Width:

Marker Style:

| Circle

Editing Marku 0: Once you draw a new Markup Shape, it can be edited. Click on the “Edit” tool on the Tools Tab.
Each white/gray circle (node) can be moved and the entire shape can be scaled. Once the color and or shape is as
desired, click outside of the shape or click the “Edit” tool again to stop editing.
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Vicinity Map Steps

Li

. _'L} Use arrows to mowe, R to rotate, § to scale, V to select vertex. Combine with ALT for finer control. Combine with SHIFT to reverse,

Snapping

Use enable or disable snapping to turn snapping on and off. This will allow you

to snap to existing data such as parcel boundaries. Click on the “Select Snapping el Q = BR
” . Point Disable Snappin Select Snapping Styles

Layers” tool to select the layers that need to be snapped to. By default, snapping Layers

is enabled to County Maintained Roads and Parcels. Click on the “Styles” tool to
change the mark-up symbology.
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Vicinity Map Steps

Removi ng Aerial: Change Layer Theme to “PW Vicinity Map”, Making this

change may turn off layers that you would like on in your Vicinity Map. You will need
to turn them back on.

Step D: Add Text (Optional)

Vicinity Maps should not have aerial imagery visible in the map.

If needed, be sure to add text last. Arrows for pointing to projects will be added in
Adobe Reader. Text does not scale so it will move if you zoom in or out. To place
text, click on the T Text button. The Style section of the toolbar will become active.
The text size, font and color can be edited before placing text on the map. To place
text, click on the map where you want it to go. A box will appear. Type text into the
box. Click off the box to stop editing and to complete the placement of the text. If

the text needs further editing, click on the ==" E9 hutton and Click on the text. Then
click on the Styles button to bring up your options for editing the text. While in edit
you can also move the text box.

To remove all text and mark ups, click on the “Clear All” button. To remove one
shape or text, click on the “Erase” button and click what needs to be removed.

*Some people prefer to add text on the final PDF.

o
2
¥

M
v Vicinity Map

Filter

M T n <
T 1 _?L
¢ o O Q
Default Frahand Shaps  Elipse  Cirde  Polygon
oo 0. P

Filter

Enter new text.

fest

0K

Cancel
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Vicinity Map Steps
Step E: Format the Print (Save) map
Printing

For a how-to video on printing click here.

Eile Home Map Tools

» B B8

it 8 Fring

Dpen

On the File tab, click on “Print” which will allow you to Save a map as a PDF or JPG file.

When the Print Map dialog screen is open, a red transparent rectangle will show up on the map. This is the area that will
be included on your map. By default, if you pan or zoom the red transparent box will continue to cover the same area
on the map. If you want to change the area covered by the map, click in the check box next to “Lock print preview with

”
map.
= O X
W PW GeoWorks x +
C A Notsecure | gisslocounty.ca.gov/Html5Viewer/Index htmlZviewer=PW.GeoWorks# Tr 0¥ @® a

Hi Apps @@ PublicWorks | Al Elf PWintranet W PWinternst W\ Record Map Index @0 ArcGIS Server Manac B gisdevpubT Sites »

- " - i
County off San Luis O{"”f"’ Department of Public Works

Eowo RKS Geospatial Information Sys B Q S

File Home Map Tools Tool Labels X

CUNING > M AN * e & ¥ 2]

Pan ZoomIn  Full Extent Bookmarks  Previous Extent Identify Print Export Getting Started

Navigation Find Data Tasks Help
Print Map x
%
Z

Select Layout
8.5X11 Portrait Vicinity Map w/ Small Inset v

o

Qutput Format —
Pdf v

Resolution m\
Medium v /

Map Scale bs\‘“c
1:4,800 (1 in. = 400 ft) M

=1

Map Title %,;,
TITLE IN B
ALL CAPS

Community in Title Case, CA

Type of Map
VICINITY MAP

Rd

Department

I
DEPARTMENT OF PUBLIC WORKS
County /—\

COUNTY OF SAN LUIS OBISPO

Created by
BJClose

Camino|Real

\Hﬂ.’lu Ave

W Lock print preview with map

.

Print | | Cancel \

|

County pf San Luis Obispo Department of Publi...
(R

—
ayers | =) Print Map

1]
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file://pubpwd01/DevMaps/GeoWorks_Docs/Videos/16_Print.mp4

Vicinity Map Steps

Select a Layout: The preferred layout for BOS Packets and Press Releases is the “8.5X11 Portrait Vicinity Map w/ Small
Inset” or 8.5X11 Portrait Vicinity Map w/ Small Inset (Long title.)

Output Format: PDF is the best for BOS Packets and Press Print Map »
Releases. Use JPG if the map needs to be added to a

PowerPoint Presentation or Word Document.
Select Layout

Map Scale: Change the Map Scale if an even scale is desired 8.5X11 Portrait Vicinity Map w/ Small Inset v

and not just the current map scale.
Output Format

Map Title: The Map Title can be three lines with 8.5X11 Pdf v
Portrait Vicinity Map w/ Small Inset map template and 4

lines with the long title version. In The first 1 or 2 lines Resolution

should be the title of the project and should be consistent Medium v

with the BOS Staff Report title and be in ALL CAPS. Do not
use abbreviations in the title. The next line should be the
contract. This is required if one is available. The last line

should be the community the project is in, capitalize the first Map Title

Map Scale
1:4,800 (1 in. = 400 ft.) v

letter of each Word in the Community Name. TITLE IN

Example: ALL CAPS

EL CAMINO REAL Community in Title Case, CA
BRIDGE REPLACEMENT PROJECT

Contract #111111 Type of Map

Atascadero, CA VICINITY MAP

Created by: Add your Username or Full Name but no initials. Department

This is so BOS packet reviewers can follow up with questions DEPARTMENT CF PUBLIC WORKS
if needed.

County
Example: COUI:ITY OF SAN LUIS OBISPO
Bobby Jo Close
BJClose Created by
BJC (This is not OK
(This is not OK) BJClose
The remaining fields can be edited but should remain as is for Lock print preview with map

BOS Packets and Press Releases.
Print | | Cancel

When the text has been updated and the area covered by
the red box is what you need on your map, click “Print”

It will take a few seconds to the map to generate. When your file is ready, the dialog screen will give you an option to
open the file. Click “Open File”

The PDF should open in your browser. Save (download) the file to your project folder and open it with Adobe Reader.
The version of Adobe Reader or Adobe Acrobat will determine how you save the map to your computer. Some versions
allow you to up the PDF from your browser. No matter what your process it. The Vicinity Map must be opened in the
Adobe program and not in your Internet

Browser for the next step. ¢: 4 ]
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Vicinity Map Steps

Example an exported map.

3102 BR1

VICINITY MAP N v
EL CAMINO REAL BRIDGE REPLACEMENT N\ Mgntorey CountyY, _fings County_ |
BRIDGE 3102 - BR1 R
Contract#111111
Atascadero, CA
COUNTY OF SAN LUIS OBISPO Pacific Ocean }
DEPARTMENT OF PUBLIC WORKS

Kem County

1: 4,800 Map by: JECasey
0 400 800 Feet Printed: 5/10/2022
‘:—:i

County
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Vicinity Map Steps
Step F: Add Project Arrow in Adobe Reader

Add Project Location Arrows

[ == i
= Edit PDF v
o Click stamp. s
. . . C nt
&y If the stamp is not showing, click “More Tools” ommen
= f.i-ﬁ Combine Files v
Then click open under the stamp Organize Pages v
eE g 4 Redact
- O Protect
L -
[Oeen -] g Optimize PDF
- : Fill & Sign
@ Abar will appear top center. Click “Custom Stamps” then “Create...” Z2 S
4 x& Send for Signature
,g. Stamp - & Stamps Palette & Custom Stamps ~
xh Croat Send for Review
Create...
Manage... J& More Tools

B
%

Browse to the arrows location and add to pdf arrow. (\\wings\public
works\Groups\GIS\PUBLIC\ VICINITY MAPS\ MapArrows) Select OK

Type Arrows in Category. You will only need to do this once to create a folder for all of you arrows. When adding the
second arrow you will be able to choose “Arrows” from the category dropdown.

Under name, name the arrow to match the one you selected. Repeat until you have added all arrows

Create Custem Stamp b

File: [S/_MapArrows/PROJECT_SITE_AF Browse...

Category: | Armows v
Sample
Name: \Prmm site

Tout of 1images

Vicinity Map Standards and Tutorial
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file://wings/public%20works/Groups/GIS/PUBLIC/_VICINITY_MAPS/_MapArrows
file://wings/public%20works/Groups/GIS/PUBLIC/_VICINITY_MAPS/_MapArrows

Vicinity Map Steps

Once the stamps are created, they will appear in the Arrows section. To see use your stamps, select Stamp, then
Arrows, pick an arrow and then place it on the map. The stamp will stay in you arrow folder after the program has been

closed.

&. Stamp - & Stamps Palette & Custom Stamps =

' APPROVED |

Arrows 3

Dynamic 3

Sign Here 4

Standard Business 4

Add Current Stamp To Favorites PROPOSED
BOUNDARY,

Show Stamp Names
BOUNDARY,

Paste Clipboard Image as Stamp Tool j
™

There are the 4 arrows available:

PROJECT
BOUNDARY,

1: Project Site Point 3: Project Boundary, use
to project location for larger projects

2: Use on

Countywide Inset 4: Proposed Boundary,

map use when proposing a
new boundary to BOS for
approval.

Add a Project Site arrow and a Site arrow in the Inset. Save
the updated map.

West Centre St

a3

PROJECT
BOUNDARY,

Vicinity Map Standards and Tutorial
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Vicinity Map Steps

Examples

|

3102 BR1

VICINITY MAP

EL CAMINO REAL BRIDGE REPLACEMENT N Jegmnrongl_paciy |
BRIDGE 3102 - BR1 K
Contract#111111 K County
Atascadero, CA
COUNTY OF SAN LUIS OBISPO Pacific Ocean }

DEPARTMENT OF PUBLIC WORKS

Santa
Barbara
County

1: 4,800 Map by: JECasey
0 400 800 Feet Printed: 5/10/2022
\:—:’
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Vicinity Map Steps

An example of a map with a boundary.

v
@ z
HES = lita e
Q=1 E? =
Slol |5 P> =
West Centre St o=l ]= S 5
< W = =
7 ERS L L &
- -
PROJECT @ :
BOUNDARY, =

SH

=]

-a m

14 =

o S

g =

0 o

S @

. 5

=

c

o

Starkey Rd -

VICINITY MAP \ Monferey County UI Kings County |
SHANDON COUNTY SERVICE AREA 1 2
CSA 16 -
Shandon, CA
COUNTY OF SAN LUIS OBISPO
DEPARTMENT OF PUBLIC WORKS T
1: 15,840 Map by: BJClose
DI' 1,320 2=540|| Feet Printed: 1/22/2019
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